
 

 

 

 

 

User Manual 

 
 
 
 
 

 



Five Wire User Manual  

 
 

 
Rev. 2.2 

  

 
Copyright © 2018 Anewin, LLC. All rights reserved.  
www.fivewirelogic.com Page 2 of 59 



Five Wire User Manual  

 

Table of Contents 

User Manual 1 
Table of Contents 3 
General Safety Summary 6 
Preface 6 

Purpose of the Document 6 
Organization of this Manual 7 

Section 1 General Information 8 
Introduction 8 
Features 8 
Standard Accessories 10 
Optional Accessories 10 

Section 2 Preparation for Use 11 
Introduction 11 
Software Installation 11 
Standard Directory 11 
Configuration 11 
Five Wire Instrument Connectors and Indicators 11 

Left Side Panel 11 
Front Panel 11 

Five Wire Application Start-up 13 
Section 3 Operation 14 

Introduction 14 
System Tool 14 

System Window Controls 14 
Other User Controls 14 

System Operation 15 
Instrument Power 15 
System Status Indicators 15 
Save and Restore the System Configuration 15 
User scripts 16 

Live Logic Tool 17 
Live Logic Window Controls 17 
Other User Controls 18 
Keyboard Accelerators 22 

Live Logic Operation 23 
Live Logic Acquisition 23 

 
Copyright © 2018 Anewin, LLC. All rights reserved.  
www.fivewirelogic.com Page 3 of 59 



Five Wire User Manual  

Acquisition Termination 24 
Continuous Mode Acquisition 24 
Single Acquisition Mode 24 

Waveform Source Tool 26 
Waveform Source Window Controls 26 
Other User Controls 28 

Waveform Source Operation 29 
Waveform Execution 29 
Run Modes 29 
Custom Waveforms 30 
Waveform Source Output Events 30 

Logic Source Tool 31 
Logic Source Window Controls 31 
Other User Controls 32 

Logic Source Operation 34 
Run Modes 34 
Custom Run Mode 34 
Generating Logic Source Output Events 35 

Logic Analyzer Tool 37 
Logic Analyzer Window Controls 37 
Other User Controls 38 
Keyboard Accelerators 43 

Logic Analyzer Operation 44 
Setting Triggers 44 
Time Qualified Triggers 44 
Acquisition Termination 45 

I2C Protocol Tool 47 
Instrument Front Panel Controls 47 
I2C Protocol Window Controls 47 
Other User Controls 48 

I2C Protocol Operation 49 
Master Mode 50 
Slave Mode 51 
Timeout Conditions 51 
Master Stop On Address NACK 51 

Trigger I/O Protocol Tool 52 
Trigger I/O Protocol Window Controls 52 
Other User Controls 52 

Trigger I/O Protocol Operation 53 
Trigger outputs 53 

 
Copyright © 2018 Anewin, LLC. All rights reserved.  
www.fivewirelogic.com Page 4 of 59 



Five Wire User Manual  

Trigger Inputs 53 
SPI Protocol Tool 54 

Instrument Front Panel Controls 54 
SPI Protocol Window Controls 54 
Other User Controls 56 

SPI Protocol Operation 57 
Master Mode 57 
Slave Mode 57 
Sequence Commands 57 
Triggers 58 

 
 

 

 
  

 
Copyright © 2018 Anewin, LLC. All rights reserved.  
www.fivewirelogic.com Page 5 of 59 



Five Wire User Manual  

General Safety Summary 

The Five Wire has been designed to provide years of safe, reliable operation. Key 
safety features include: 

● Operation from UL listed isolated power supply 

● Low power operation (7.5V @ 1A fused internally) 

● Metal enclosure 

For your safety, please: 

● Only operate the Five Wire using the supplied power adapter. Use of 
other power adapters could create a safety hazard or cause damage 
to the Five Wire. Damage from using an improper power adapter is 
considered abuse and is not covered by the factory warranty or 
extended service contracts. (Replacement power adapters are 
available at www.FiveWirelogic.com). 

● Do not use the Five Wire in high voltage circuits. The Five Wire is 
designed for digital test and debug. All I/O (input/output) signals 
should be limited to a 0 – 5V range. Live Logic inputs using the 
provided 10X probes have an extended input range, 0 - 16V. 

● Only use the Five Wire for its intended purpose – digital circuit 
design and debug. If you have any questions about safe operation or 
intended use, please contact Five Wire. 

Preface 

Purpose of the Document 

The Five Wire User Manual provides comprehensive information regarding the 
configuration, operation, and performance limits of the Five Wire. Please refer to 
this User Manual for detailed operation instructions. 

The Five Wire Application user interface has been specifically designed to be easily 
understood, allowing operation without referencing documentation. Together, the 
application user interface, Tool Guides, and User Manual provide reference 
materials to help users get the most out of their Five Wire product. 
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Organization of this Manual 

The User Manual is organized by sections: 

Section 1 provides a high level overview of the Five Wire and its 
operation. 

Section 2 describes installation and setup of the Five Wire for first 
use. 

Section 3 provides instructions on the use of each of the Five Wire 
tools. 
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Section 1 General Information 

Introduction 

 Five Wire is a next-generation integrated instrument. Leveraging state-of-the-art 
technologies, highly integrated architecture, and the computing performance of 
modern PCs, the Five Wire provides a versatile, high performance digital test 
instrument for embedded and digital engineers. 

Features 

Five Wire provides five integrated tools: Live Logic TM Logic Source Pattern 
Generator, Waveform Source Arbitrary Waveform Generator, Logic Analyzer, and 
Protocol Test. Each of the Five Wire tools was designed to provide the features 
required for modern microcontroller and digital design. 

Live Logic provides the feel and ease of use of a two-channel oscilloscope but is 
specifically designed for digital engineers. Two 10X oscilloscope probes are 
provided for easy probing of your logic signals and clocks. The acquisition display is 
continuously updated, displaying your signals auto-scaled for easy viewing. 
Browsing from clocks to strobes to controls is a snap. 

Live Logic also includes a digital voltmeter (DVM) on each input channel. The DVM 
allows you to use the same Live Logic probes to verify logic supplies or levels, or to 
measure the duty cycle of logic signals, such as pulse-width modulated (PWM) 
control outputs. An activity Indicator lights whenever the input signal is toggling. 

The Logic Source tool is a full-featured pattern generator. It provides 9 output 
channels with programmable high and low drive levels. The pattern memory 
contains 1020 vectors with programmable duration from 30ns to 40ms settable in 
10ns time increments. Looping and conditional branching allow continuous and 
triggered vector bursts to be generated. 

The Waveform Source provides two instrument capabilities. It can generate a 
programmable arbitrary voltage waveform with an output range of 0 to 5V and sine 
wave frequencies from 0.002Hz to 50KHz. Standard waveform types can be created 
or the user can develop custom waveforms using standard CSV format. Looping and 
conditional branching allow complex waveforms to be generated and support the 
triggered waveform outputs. 

The Waveform Source can also be used as a programmable power supply. It can 
source up to 100mA of current, and its output amplifier has been specially designed 
to drive capacitive loads. Combining the arbitrary waveform nature of the 
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Waveform Source with the power supply capability allows evaluation of power 
supply dynamic behaviors such as power supply turn-on and turn-off cycles.  The 
discharge/charge behaviors of batteries can be simulated to test brown-out 
routines. 

The Protocol tool actually comprises several tools in one. It dynamically configures 
itself depending on which dedicated protocol probe is attached. Three different 
protocols are supported by the Five Wire: Trigger, SPI, and I2C.  The Trigger 
Protocol provides 3 trigger signal inputs and 3 trigger signal outputs.  Each tool 
within the Five Wire can produce and accept a triggering event. For example, events 
can be used to trigger acquisition tools or to trigger a pattern source output 
waveform, coordinating the signals to another Five Wire tool or the user circuit. For 
a full discussion of Five Wire Events refer to section 3. 

The SPI Protocol probe provides both master and slave capabilities for shift chains 
from 1 to 4 bytes in length. In master mode, predefined output vectors are sent to 
the slave via SDO and the return data on SDI is captured for display. Up to 128 
sequential vectors can be sent. Signals included are Master SCK, SDO, SDI, and Select 
out. In slave mode, the data sent from the master is captured for display and user 
defined vectors are returned to the master on SDO. Signals included are Slave SCK, 
SDO, SDI, and Select in. 

The I2C Protocol probe provides both master and slave transactions. It includes a 
capture queue and a predefined pattern send queue. Signals included are SCK and 
SDA. Both are open-collector drive and bi-directional. 

The Logic Analyzer is a full-featured 9 channel, 100MHz logic analyzer. It provides 
3 level sequential triggering including time qualified triggering. Time qualified 
triggering can be used to catch signals that are too short (glitch) or signals that are 
too long (hang). Captured data is displayed in timing diagram format and includes 
user defined labels, display order, and time measurements. 

All of these tools are integrated into a single System with shared trigger events that 
allow the tools to interact. For example, a protocol trigger or logic source pattern 
can send an event to the Waveform Source causing a simulated analog input 
waveform to be generated. The Five Wire was designed to solve the kinds of 
problems facing today's embedded designers. 
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Standard Accessories 

The Five Wire includes these standard accessories: 

● Two 10X 100MHz scope probes 

● Logic Source probe 

● Logic Analyzer probe 

● I2C Protocol probe 

● One Five Wire Wall Outlet Power Adapter (7.5V power supply) 

● One USB A-B cable 

Optional Accessories 

Also available from Five Wire are these optional accessories: 

● SPI Protocol probe 

● Trigger I/O Protocol probe 

● Replacement 7.5V power supply 
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Section 2 Preparation for Use 

Introduction 

The Five Wire is a PC hosted instrument. The PC runs the Five Wire software 
application and communicates with the Five Wire instrument via a USB cable. The 
Five Wire instrument also requires external power provided by the supplied 7.5V 
power supply. 

Software Installation 

The Five Wire application is available on the Five Wire website for download. 
Follow the installation instructions.  

Standard Directory 

The Five Wire application provides the ability to save the current configuration and 
to save data files associated with each tool. The application includes a standard Five 
Wire directory in Documents that is created at installation.  

Configuration 

After the Five Wire software application has been installed, the Five Wire may be 
connected to the PC via one of its available USB ports. The Five Wire instrument USB 
connector can be found on its left side panel. 

Connect the Five Wire 7.5V power supply wall plug to an appropriate 100-240V 
receptacle and insert the supply's low-voltage barrel connector into the Five Wire 
power socket. The Five Wire is now ready for operation. 

Five Wire Instrument Connectors and Indicators 

Left Side Panel 

USB connector: Provides communication between the Five Wire instrument and 
the Five Wire application. 

Power Supply connector: Provides Instrument power. Must be connected using 
the provided Five Wire 7.5V power supply. 

Front Panel 

Power button and LED: When the Power LED is illuminated, the Five Wire 
instrument is ready for operation and can drive its output signals and capture input 

 
Copyright © 2018 Anewin, LLC. All rights reserved.  
www.fivewirelogic.com Page 12 of 59 



Five Wire User Manual  

waveforms. If the Power LED is not illuminated, the Five Wire instrument is not 
powered. 

The Five Wire powers up automatically when the application is opened. When the 
Five Wire Power LED is illuminated, pressing the Power button for approximately 5 
seconds will turn the instrument power off and close all tool windows. 

Link LED: Illuminates when data is being transferred between the Five Wire 
application and the Five Wire instrument. 

System button: Asserts the System Event when pressed. See the System 
description in Section 3 of this manual. 

Zoom and Scroll knobs: Change the waveform scale and display position of the 
active acquisition tool window. See Live Logic and Logic Analyzer tool descriptions 
in Section 3 of this manual for tool-specific operation. 

Live Logic Run LED: Illuminated when the tool is acquiring a new waveform. 

Live Logic Trigger LED is illuminated if the last Live Logic acquisition captured the 
selected trigger event. 

Live Logic Capture button: Starts an acquisition or terminates an ongoing 
acquisition. 

CH1 and CH2 LEDs: Provides an immediate indication of signal activity. When the 
Live Logic probe is connected to a logic signal which is transitioning, the LED will 
momentarily flash. If the signal transitions are continuous the LED will be 
illuminated continuously. The LEDs provide a quick and easy way to check for signal 
activity. 

CH1 and CH2 BNCs: These connectors accommodate the 10X oscilloscope probes 
provided as standard accessories with the Five Wire. The Five Wire Live Logic is 
designed to use 10X scope probes. If probes other than those supplied with the Five 
Wire are used, make sure they provide a 10X attenuation. Using 1X probes will 
produce incorrect operation and results. 

Waveform Source Run button: Starts a waveform execution or terminates an 
ongoing waveform execution. 

Waveform Source Run LED: Indicates that the waveform is being executed. When 
execution is stopped, the last waveform output value that was executed remains on 
the output. 

Red and black binding posts. These provide the Waveform Source outputs. The 
black binding post provides a signal ground reference and is directly tied to the Five 
Wire enclosure. The red binding post provides the Waveform Source active drive 
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signal. 

Protocol Send button and LED: Button operation and LED illumination is 
dependent on the currently active protocol. See Section 3 of this manual for protocol 
specific operation. 

Protocol connector: Provides connection to the Trigger, SPI, or I2C protocol 
probes. Note that a Protocol probe must be installed for the protocol tool to become 
active. 

Logic Source Run button and LED: The Run button starts or terminates pattern 
execution. The LED is illuminated when a pattern is being executed. When execution 
stops, the last pattern vector executed remains on the output. 

Logic Source connector: Provides connection to the Logic Source probe. Note that 
the probe must be installed before patterns can be executed. 

Logic Analyzer Run button and LED: The Run button starts or terminates a 
waveform acquisition. The LED is illuminated during the acquisition and will be 
extinguished when the acquisition terminates. 

Logic Analyzer connector: Provides connection to the Logic Analyzer probe. Note 
that the probe must be installed before an acquisition can be started. 

Five Wire Application Start-up 

To start the Five Wire application, double-click the Five Wire application icon on 
your desktop or select the application using the PC start menu selecting the Five 
Wire application. 

When operating the Five Wire instrument, the instrument should be connected to 
the PC via a USB cable, and the Five Wire Power Supply should be properly 
connected before starting the Five Wire application. 

The Five Wire application may also be run without connection to the Five Wire in 
View Mode. When in View Mode tool windows can be opened, waveforms can be 
loaded, and patterns can be edited and saved. Note that some functions are not 
available unless the Five Wire instrument is available and connected. 
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Section 3 Operation 

Introduction 

This section provides  instructions for the operation of each tool. For further 
information about tool saved file formats see Section 5 of this manual. For further 
information about tool scripting support see Section 6 of this manual. 

System Tool 

The Five Wire System tool window is 
opened when the Five Wire application is 
started. The System tool manages 
functions that are shared by all Five Wire 
tools. Its primary purpose is to provide 
system status information and to launch 
the other Five Wire instrument tool 
control windows. 

System Window Controls 

System Connected LED: Illuminated (orange) if the USB connection to the Five 
Wire instrument is operational. The indicator is gray when not illuminated. 

System Ready LED: Illuminated (orange) when the Five Wire is powered and the 
Five Wire Power Supply is properly connected and providing power to the 
instrument. 

Tool Launch buttons: Each button (Live Logic, Waveform Source, etc.) launches 
its respective tool control window or moves the tool control window to the top of 
the PC display. Tools may also be launched from the View menu. 

Other User Controls 

File, Open/Save As...: Saves the current tool configuration or opens a previously 
saved configuration. Tool configuration includes the current settings for each tool 
that is open including source patterns and captured waveforms. 

File, Run Script: Opens and runs Five Wire script files. Scripts can be used to 
configure tools for a specific activity. For more information on Five Wire script files, 
see the Five Wire Script Reference Manual. (MBScript reference. In the application system 
window click Help->Open Script Reference) 
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System Operation 

Instrument Power 

When the Five Wire application is started, the Five Wire instrument will power up. 
The front panel Power LED will illuminate and the System window Ready indicator 
will become orange. When the Five Wire application is closed the Five Wire 
instrument will power down. 

The instrument can also be powered down by pressing and holding the instrument 
Power button for approximately five seconds. When the instrument powers down 
all tool control windows will be closed and the application will close. 

System Status Indicators 

The System Window provides two status indicators in the system group box. The 
Connected indicator is green when the USB connection to the Five Wire instrument 
is operational. The USB connection is configured automatically when the instrument 
is connected to a PC using the supplied USB cable. 

The Ready indicator is green when the Five Wire instrument is powered and the 
Five Wire Power Supply is properly configured. 

Save and Restore System Configuration 

The configuration of the currently open tool set can be saved and then later restored 
by selecting File, Save As... from the System Window menus. A set of Five Wire 
configurations files will be stored in the selected directory. Multiple (different) 
configurations can be saved by selecting a different folder to store the file set. Do not 
change the file names. These predefined file names are always used when 
restoring a configuration. 

Saved system configurations include the settings of tools that are open at the time of 
the system save. It includes the state of all control settings but not the current 
running state. 

The System window generates a savedSystem.csv file in the selected directory 
when the system is saved. Each tool that is open also generates one or more of its 
own configuration files in the same directory. If the saved configuration is moved or 
copied to a new directory, all files in the original directory must also be copied to 
the new directory. 

A previous configuration is restored by selecting File, Open in the System Window 
menus. Click open to restore the system from the default directory, or navigate to 
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the desired restore directory and click Open. Each saved tool is opened and 
configured. Tools that were not part of the system save are not affected during 
restore. 

User Scripts 

The Five Wire supports a scripting language that provides the ability to run 
automated tests. Users can write their own scripts using a simple text editor such as 
Notepad. See the Five Wire Script Reference Manual for a complete description of 
scripting. 

User defined scripts are executed by selecting File, Run Script in the system tool 
window. Navigate to the directory and file name of the script you wish to run and 
click OK. The user script is then executed. If problems are found in the script during 
execution, an error message will be displayed and script execution will be 
terminated. 
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Live Logic Tool 

The Live Logic tool is 
designed to allow digital 
designers to quickly view 
logic and voltage signals 
without requiring complex 
setups. Live Logic 
provides two channels of 
400MS/s digital capture 
for active logic signals 
with a live 
oscilloscope-like display. 
Easy circuit probing is 
provided using the 
supplied 10MΩ, 10x scope probes. The CH1/2 LED indicators instantly show if the 
probed signal is actively toggling. Display auto-scaling allows hands-free operation 
so signals of interest can be quickly probed. An integrated DVM measures and 
displays the average voltage at each probe tip for verification of power supply 
voltages, hi or low logic signals, or the average value of a PWM signal. 

Live Logic Window Controls 

VCH1, VCH2: Displays the average voltage measured on channels 1 and 2 of the 
probed signal(s). 

Waveform Display: Displays captured digital waveform. The timescale indicates 
the times at which edges occur. The Samples value indicates the number of edges 
that must be captured during acquisition to avoid a timeout. The selected logic 
family is displayed below the Samples. The span indicates the period of time 
currently being displayed. 

Run Control Button: Start or stop acquisition of a new waveform. 

Run Control Selections: Selects the acquisition mode. In continuous mode, 
acquisitions are taken repeatedly. Each acquired waveform is scaled to fit in the 
waveform window for easy viewing. In Single mode, a single acquisition is taken 
each time the Capture Button is pressed. 

Trigger Value: Click the waveform to select a trigger condition. When a trigger is 
detected and there are a sufficient number of edges, the captured trigger value will 
be placed at the selected location on the screen. 
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Trigger Position: Sets the location of the trigger within the acquired waveform. 
Trigger position selects the number of samples before and after the trigger based on 
the Samples selection. 

Trigger Type: Level trigger will stop the acquisition when the selected trigger is 
satisfied. Duration and Pulse triggers place additional timing requirements on the 
acquired signal to satisfy the trigger condition. External triggers are supplied by 
other Five Wire tools. See Advanced→Trigger In menu. 

Trigger Timeout: Sets the maximum time that an acquisition will run. Acquisition 
terminates when sufficient edges have been captured or the duration of the 
acquisition exceeds the timeout value. 

Samples: The number of samples that are captured in each acquisition. When in 
Continuous acquisition mode, the number of samples can also be changed by the 
front panel Zoom knob or the mouse scroll wheel. 

History: The last 10 acquired waveforms are stored in the history memory and can 
be displayed using the history control. Select 0 for the latest waveform and 9 is the 
oldest waveform. History is only available when not acquiring waveforms. 

Other User Controls 

Zoom Waveform: Captured waveforms can be scaled by zooming in or out. Zoom 
can be adjusted using the: 

● Front panel Zoom knob 

● Selections in the View menu 

● Selections in the waveform display window right-click menu 

● Mouse scroll wheel (if Wheel Zooms is selected in the waveform right-click 
menu) 

● Drag zoom 

● Double-click zoom 

● Accelerator keys 'i' and 'o' 

When both A and B marks have been set (See Set Mark A/B below) you can zoom to 
the extent of the marks by selecting Zoom Marks in the waveform display 
drop-down menu or by pressing the 'm' accelerator key. This places the two marks 
near the left and right sides of the display window. 

You can zoom in on a region of the display by dragging the mouse across the time 
area of interest in the waveform display (drag zoom). To drag the mouse, press and 
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hold the left mouse button at the starting time to be zoomed. Continuing to hold the 
left mouse button, move the cursor to the ending time to be zoomed. Release the left 
mouse button to complete the zoom area. Area zoom only uses the horizontal (time) 
selection: vertical mouse movement during the drag is ignored. Area zoom may be 
repeated multiple times to view the details of a narrow pulse when a large time span 
is currently displayed. 

You can also zoom by double-clicking on the display. The location of the double-click 
is centered and the scale magnified. Continuing to double-click on a feature of 
interest zooms closer to that feature. 

Scroll Waveform: Captured waveforms can be shifted left/right to view waveform 
data that is currently out of view. Scroll position can be adjusted using the: 

● Front panel Scroll knob 

● sMouse scroll wheel (Select Wheel Scrolls in the waveform right-click menu 
or 's' key) 

● Accelerator keys 'j' or 'k' 

Scroll is only available when the acquisition is stopped. 

Center This: Accessed in the waveform display right-click menu, Center This scrolls 
the display to place the location of the mouse at the time of the right-click in the 
center of the waveform display. 

Goto: Accessed in the waveform display right-click menu, Goto Trigger, prior edge, 
and next edge scrolls the waveform display to place the selected item at the center 
of the display. Goto Mark presents a drop down list of currently placed marks and 
comments. Selecting a mark or comment from the list will center that mark or 
comment in the display. 

Open: Opens a previously stored waveform file for viewing 

Save As...: Saves the currently displayed acquisition to a waveform file. The 
waveform can then be opened later for viewing. 

Set Mark: Set Mark places a display mark at the position of the cursor. To place or 
remove a mark on the waveform: 

● Right-click on the waveform at the desired location and select “Set Mark” 
and choose the type of mark 

● Position the cursor at the desired location and click one of the set mark 
accelerator keys: a mark, b mark, ref, time, or quick 

● Press the undo mark accelerator key to remove the last mark that was 
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placed 

Marks will snap to a waveform edge if it is within 8 display pixels of the selected 
point and within the waveform. To avoid snap to edge place the cursor outside of 
any waveform or away from a waveform edge. 

When A and B marks are placed, the time difference or frequency (1/time 
difference) between the marks is displayed. Use '/' accelerator key to toggle 
between frequency and time. 

When a Time mark is placed it displays the relative time at that location. If a 
Reference Mark is also placed, the Time marks display the time relative to the 
reference time. If no reference mark has been placed then Time marks are relative 
to the start of acquisition. 

Notation marks allow you to enter the text label associated with the mark.  To set a 
notation mark, click in the text box that is opened when Notation is selected. Type 
the label text and then press Enter to set the mark. 

Set Comment: Comments are like Notation marks (see Set Mark description) except 
that they do not include a mark line and do not snap to edges. 

Save View: Adds the current view to the list of annotations with a user defined 
name.  

Show View: Restores a named view. 

Delete Mark or Comment: Presents a drop down list of marks and comments that 
are currently set. Selecting a mark or comment from the list deletes that mark or 
comment.  The last mark that was placed can be deleted using the 'u' accelerator 
key. 

Set Quick Mark: This mark is like a time mark except that only one Quick Mark can 
be placed at a time. Once a Quick Mark is placed, left-clicking the waveform moves 
the Quick Mark to the click location allowing different time points to be quickly 
measured. 

Delete All Marks and Comments: Deletes all of the currently set marks and 
comments. 

Analyze: This menu provides access to the measure and decode functions. 

Measure: Clicking this item will open a drop down selection which sets a 
measurement on each channel. Measurements include frequency, period, 
pulse-width, and duty cycle. 

Select Decoder: Clicking this item will open a drop down selection which allows 

 
Copyright © 2018 Anewin, LLC. All rights reserved.  
www.fivewirelogic.com Page 21 of 59 



Five Wire User Manual  

one of the decoders to be enabled. Current decoder functions include SPI, I2C, 
RS232, and LIN. When a decoder is selected, a configuration dialog is presented 
which is specific to the selected decoder. The configuration dialog allows you to 
assign input channels to the decoder specific signals such as the I2C SCK and SDA 
signals. Different decoder definition files (.dcd file extension) can be assigned to the 
analysis. Clicking the OK button completes the configuration. 

Configure Decoder: Clicking this item will reopen the configuration dialog allowing 
the configuration parameters to be modified. 

Enable Decode: Enables execution of the decoder after each acquisition. Each 
transaction is marked with a box mark and decoding text is generated which 
describes the content of the transaction. 

Refresh Decode: Erases the current decoder marks and reruns the decoder on the 
current data. 

Clear Decode Marks: Removes all decoder marks for the currently selected 
decoder. 

The decoder functions work on serial data streams. Decoding the information 
requires that the analyzer align the start of decode with the acquired data set. In 
some cases the data set begins with a partial transaction that includes only a portion 
of the protocol. In these cases the decoder will attempt to form synchronization but 
may be unable to synchronize if insufficient information is available. In these cases 
the user should place a Begin Analysis mark at a location between transactions to 
force correct alignment. Right click in the waveform display and select Set Mark -> 
Begin Analysis. 
If transactions are close to each other in the display their decode text may overlap. 
Zoom in to spread the transactions further apart to eliminate the overlap. 

Logic Family: The logic family being probed can be selected in the Advanced, Logic 
Family menu. The logic family setting is used to determine the logic state of a signal, 
1 or 0. 

Trigger In: Selects which Five Wire tool will be the source of the Live Logic trigger 
(when Event is selected in the trigger Watch For box). 

Trigger Out: Selects when the Live Logic tool generates an output event. 

Clear History: Removes all stored acquisitions from the history memory. 
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Keyboard Shortcuts 

Both Live Logic and Logic Analyzer provide keyboard shortcuts that make viewing 
waveforms fast and efficient. Each accelerator key has a corresponding context 
menu control. Below is a list of keys and their function. 

 

Key   Function 

i Zoom in 

o Zoom out 

j Scroll left 

k Scroll right 

n Goto next edge 

p Goto prior edge 

N Goto next edge, jump past local activity 

P Goto prior edge, jump past local activity 

a Set mark A at the cursor location 

b Set mark B at the cursor location 

m Zoom to A and B marks 

z Set mouse wheel mode to zoom 

s Set mouse wheel mode to scroll 

q Set quick mark at the cursor location 

r Set the reference time mark at the cursor location 

t Set the time mark at the cursor location 

u Remove the last mark set 

/ Toggle A-B mark measurement between time and 
frequency 

1 Cycle through CH1 measurements 

2 Cycle through CH2 measurements 
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Live Logic Operation 

Live Logic Acquisition 

Live Logic captures transitions of the signals being probed. It samples the logic value 
of CH1 and CH2 every 2.5ns to see if the value has changed.  When a change is 
detected, it is stored for later display. This allows large time spans to be captured 
without losing the time resolution. 

The user can select the number of samples (transitions) to be stored. Storing 32 
samples is sufficient to determine a clock is running or to measure its period using 
marks. Observing more complex waveforms may require more samples to be stored. 
The tradeoff is the time required to retrieve the waveform data and the extra effort 
to browse a larger number of samples. 

Live Logic includes a timeout feature that will terminate the acquisition if the 
requested number of samples are not captured before the selected time expires. 
This allows a continuous display of waveforms even when no transitions are found, 
for example when no signal is being probed or the probed signal is not changing. 
Different timeout values can be selected, including None to disable the timeout 
feature. 

When an acquisition is started, Live Logic stores transitions that occur before the 
selected trigger event. To accomplish this, trigger evaluation is disabled until the 
number of captured samples satisfies the selected trigger position criteria. The Start 
trigger position enables triggers immediately at the beginning of the acquisition. 
The Middle trigger position enables triggering after half of the requested samples 
have been acquired. The End trigger position enables triggers after the requested 
number of samples have been captured. 

Once the trigger evaluation is enabled, acquisition continues until the trigger 
condition is satisfied. Once the trigger condition is satisfied, acquisition continues 
storing additional samples equal to the remainder of the requested samples minus 
the requested trigger position samples. Triggers are evaluated each time a sample is 
taken. If no samples are taken (no input transitions occur) then the trigger will not 
be evaluated. 

 

 

 
Copyright © 2018 Anewin, LLC. All rights reserved.  
www.fivewirelogic.com Page 24 of 59 



Five Wire User Manual  

Acquisition Termination 

Live Logic acquisition will terminate when one of the following conditions occur: 

1. The user presses the Capture/Stop button 

2. The acquisition time exceeds the timeout value 

3. Live Logic is triggered and sufficient post-trigger data values have been 
captured. 

Continuous Mode Acquisition 

When the Live Logic tool is launched, it starts in Continuous mode. In this mode, 
acquisitions are taken and displayed repeatedly. Each acquisition terminates when 
one of two conditions occur: the selected number of samples (transitions) have been 
captured, or the duration of the acquisition has exceeded the selected timeout 
setting. Pressing the Capture button (software or front panel) can also start and stop 
the acquisition. The number of samples and timeout values can be adjusted by the 
user to suit the type of signal being observed. 

When looking at simple signals such as square waves or simple pulses, the number 
of samples can be set to lower values to increase the display update rate while 
providing sufficient detail to see the characteristics of the captured waveform. For 
complex waveforms such as SPI transactions, the number of samples can be 
increased to capture entire transactions or a series of transactions. 

The default timeout value is set to 100ms. This setting supports acquisition of 
signals with high repetition rates that produce thousands or millions of edges each 
second. The timeout value should be increased when observing low repetition rate 
signals. These include low frequency signals or high speed signals that occur 
infrequently such as a SPI transaction that occurs once each second. 

 When switching to continuous mode from any other mode, the timeout value will 
be set to 100ms if the prior setting was none. 

Single Acquisition Mode 

Single mode captures a new waveform each time the Capture button is pressed. This 
mode is useful for manually selecting the time that acquisition is to begin. By 
extending the timeout value, an acquisition can be started and then the user can 
initiate the signal of interest in their circuit manually. This mode is also useful for 
signals with very low repetition rates such as long-period, wake-up polling signals. 

Very long periods of time can be captured. Because the Five Wire always maintains 
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full time resolution, you can observe narrow pulses (tens of nanoseconds) that 
occur seconds apart, and measure both the time between the pulses and the width 
of the pulse with full resolution. 

When single acquisition mode is selected from any other mode, the timeout value 
will be set to none. 
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Waveform Source Tool 

Waveform Source provides an arbitrary 
analog waveform output. Up to 1020 
sequential voltages can be generated 
with 10 bits of amplitude resolution. 
Waveform Source can generate 
waveforms with durations between 5µs 
and 5000 seconds with up to 0.2 µs 
resolution. 

The Waveform Source tool control 
window includes waveform generation 
features that simplify its operation. Parametrized standard waveforms can be 
generated algorithmically, eliminating the need to directly edit waveform pattern 
files. To generate a waveform, select the tab for the waveform type of interest, edit 
the waveform parameters and the V1 and V2 voltage levels, and press Generate. A 
representative display of the waveform to be generated is shown in the waveform 
display window to verify your selections. User defined waveforms can also be 
written that allow truly arbitrary wave shapes. 

Waveform Source Window Controls 

Generate Waveform box: The tabbed generate waveform box allows a number of 
standard waveform patterns to be generated algorithmically. Each tab supports a 
waveform type. Each waveform type includes parameters to specify the waveform 
characteristics. 

Generate Waveform button: Before a waveform can be executed it must first be 
algorithmically generated. Generating the waveform produces the waveform 
pattern which can be executed and saved for later use. 
 
When the Generate Waveform button is pressed, the currently selected waveform 
tab and its parameters determine which waveform pattern will be created. After a 
waveform is generated it is displayed in the waveform display window. 

One level of undo is provided when a waveform is loaded or generated. To undo, 
select Undo in the Edit menu. 

Auto Generate on Run: When checked, the waveform will be generated and loaded 
before it is executed. This is useful if different waveforms are repeatedly produced 
assuring each one is generated before it is executed. However, generating and 
loading waveforms takes time. If the same waveform is run repeatedly this feature 
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should not be checked. 

Fast Mode: When checked, the minimum point duration is 1.25µs (limited by analog 
bandwidth) and the resolution is 0.25µs. When unchecked, the minimum point 
duration is 10µs and the resolution is 5µs. Fast mode provides better resolution and 
higher frequency output waveforms. Normal mode provides longer waveform 
durations. 

Sine: The Sine waveform produces a sine wave output. The Frequency box 
determines the frequency of the waveform. The Offset box determines the center 
level of the waveform above ground. The Amplitude box determines the P-P voltage 
of the sine wave. 

The 'k' or 'kHz suffix can be used in the frequency box, i.e. 3e3 or 3k or 3kHz. The 'm' 
suffix may be used in the amplitude box, i.e. 0.3 or 300m or 300mV. 

Triangle: The triangle waveform produces an output that linearly changes from V1 
to V2 and back to V1. The Seconds box determines the period of the waveform. The 
% Duty Cycle determines the percentage of time that the waveform is rising, 0 to 
100 percent of the period. 

Time can be entered in scientific notation or by using the suffix ‘u’ for µs 
(microseconds), or ‘m’ for ms (milliseconds). For example 100 microseconds can be 
entered as 100u, 0.1m, 100e-6, or 1e-4. 

Square: The square waveform produces a square pulse output. Inputs are provided 
to set pulse high time and total pulse duration. Checking the invert box inverts the 
waveform shape. 

RC: The RC waveform produces a logarithmic shape with a settable time constant. 
The total duration of the generated waveform is 5 time constants. If the invert box is 
checked, the waveform is inverted. 

Battery: The battery waveform produces discharge curves for common battery 
types. Discharge times from seconds to hours can be generated. Multiple cells placed 
in series can be selected up to the maximum Waveform Source output voltage of 5V. 

DC: The DC supply produces a constant output voltage selected by the Output 
Voltage entry. 

Run button: Start or stop pattern execution and output. If a pattern has been 
generated or read from a file, it will be loaded prior to execution. 

Continuous mode: In Continuous run mode, the waveform pattern loops back to 
the start of the pattern when the end of the pattern is reached. This produces a 
periodic waveform output. 
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On Event mode: In On Event run mode, the waveform pattern is held at the start of 
the pattern until the selected event is asserted. When the event is received, the 
waveform pattern output will be generated. When the complete waveform has been 
output, the Waveform Source returns to the beginning of the waveform pattern and 
waits for the next event input. 

Events are received when the selected input event transitions from unasserted to 
asserted. The event cannot be received again until it becomes unasserted. 

Single mode: In Single run mode, the waveform pattern will be output once each 
time the run button is pressed. 

V2: Sets the highest voltage that generated ramp, pulse, and RC waveforms will 
produce. 

V1: Sets the lowest voltage that generated ramp, pulse, and RC waveforms will 
produce. 

Waveform Display: Displays an analog simulation of a waveform pattern when it is 
generated or loaded from a file.  

Waveform Display Scroll Bar: Scrolls the waveform display forward or backward 
in time. 

Other User Controls 

Zoom the waveform display: The Waveform Display can zoom in/out showing a 
smaller/larger time span. To zoom the display, roll the mouse wheel (if Wheel 
Zooms is selected), select Zoom In or Zoom Out in the view menu, or right-click in 
the waveform display window and select Zoom In or Zoom Out. 

The mouse wheel can be configured to zoom or scroll the waveform display. To 
change the configuration, right-click in the waveform display and select Wheel 
Scrolls or Wheel Zooms. 

Scroll the waveform display: You can also scroll with the mouse wheel (if Wheel 
Scrolls is selected; see Zoom the waveform display above). 

Select Input Event Source: In the Advanced menu select Event In and choose one 
of the available input event sources from the side menu. 

Load a Waveform File: In the File menu, select Open. Navigate to the folder that 
contains the previously stored pattern, select the file, and click Open. The waveform 
pattern is updated with the file contents. The new waveform pattern is displayed in 
the waveform display window. A single level of undo is provided for load pattern by 
selecting Edit, Undo. 
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Save a Pattern File: In the file menu select Save As... Select a folder and file name to 
store the pattern and click Save. Pattern files are saved in a human readable CSV 
format. 

Maintain Output on Stop: When waveform generation is stopped the output 
voltage is returned to 0V. Checking the Advanced, Maintain Output on Stop the 
output will continue to be the last value produced. Note that the DC supply function 
always returns to 0V regardless of this setting. 

Waveform Source Operation 

Waveform Execution 

The Waveform Source can produce arbitrary analog waveform shapes. It does this 
by sequentially executing waveform pattern lines stored in its memory. Each 
pattern line contains both a 10-bit value that defines the voltage to be output when 
the line executes and a time duration value that determines how long the voltage 
will be output. Duration values can range from 1µs to 16 seconds with a resolution 
maximum of 0.2µs. The output waveform is just a series of timed voltage outputs. 

To provide more complex waveforms, a command parameter is included in each 
waveform pattern line. Commands can alter the sequence of pattern lines executed, 
form counted pattern loops, or wait for events before executing the next line. These 
commands are used in the waveform generator to produce Continuous, On Event, or 
Single pattern types. 

The algorithmic waveform generator greatly simplifies using the Waveform Source 
for common waveforms. It includes built in algorithms for common waveform 
shapes (Sine, Triangle, Pulse, RC, Battery, DC). Once generated, the waveform 
patterns can be executed or saved to a file. 

Run Modes 

The Waveform Source provides three run modes for generated waveforms. 
Continuous mode produces a periodic waveform output. When the waveform 
pattern reaches the last output level, it will continue from the start of the waveform 
pattern. Pressing the Run button starts/stops the waveform output. 

In On Event mode, the waveform waits at the first output level of the waveform 
pattern until the selected input event is received. When the event transitions from 
unasserted to asserted, the waveform pattern is output. When the waveform pattern 
reaches the last output level it will continue from the start of the waveform pattern. 
Once again it will wait for an input event before the waveform pattern is output 
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again. Events are received when the selected input event transitions from 
unasserted to asserted. The event cannot be received again until it becomes 
unasserted. 

Input events are selected from a list in the Advanced, Event In menu. The event can 
come from another Five Wire tool or from an external signal using the Trigger I/O 
Protocol probe. 

The Single run mode outputs the waveform pattern once each time the run button is 
pressed. This allows the user to coordinate the signal manually with their circuits. 

Custom Waveforms 

The Waveform Source provides waveform generation for common waveform types. 
This greatly simplifies the use of the Waveform Source for most users. However, 
much more complex arbitrary waveforms can be generated. Custom waveforms can 
be defined using a spreadsheet. The spreadsheet is then saved in CSV format. The 
CSV waveform pattern file can be loaded into the Waveform Source to produce your 
custom waveform. 

Waveform Source Output Events 

The Waveform Source generates an output event each time the waveform pattern is 
output. In Continuous mode the events will repeat at the period of the waveform. In 
On Event mode, an event will be output each time an event is received. In Single 
mode, an event will be output each time the run button is pressed. 
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Logic Source Tool 

The Logic Source is a pattern generator 
with 9 output channels. It provides 1020 
pattern memory vectors. Each vector 
contains a 9-bit output value, a time 
duration value, and a command value. 
The vector duration determines the 
length of time each vector will drive the 
output pins. The vector duration can be 
programmed from 30ns to 40ms with 
10ns resolution. Vectors are output 
sequentially starting with line 0. If the 
vector includes a command the execution sequence can be altered to form for/next 
loops, infinite loops, and conditional branches based on event inputs. 

The Logic Source tool provides configuration, run control, and a pattern editor. 
Logic Source patterns can be saved and recalled later. Pattern files use a human 
readable CSV format which allows patterns to be generated in a spreadsheet or by 
user written programs. 

Logic Source Window Controls 

Run button: Start or stop pattern execution and output. If the pattern has been 
edited it will be loaded prior to execution. 

Continuous: In Continuous run mode, an “A:Goto 0” sequence instruction is placed 
on one of the pattern lines (default is line 15). When the “A:Goto 0” line is executed, 
execution will jump back to line 0 forming an infinite loop. The “A:Goto 0” command 
may be moved to any line, allowing different pattern repeat lengths. 

On Event: On Event run mode includes two commands. It includes an “A:Goto 0” 
command and a “B:Wait for Event then Goto 1”. The B:Wait command causes the 
line 0 vector to be repeatedly executed until the selected input event is asserted. 
When the input event is asserted, execution will proceed to line 1 and continue 
sequentially until the line with the “A:Goto 0” is executed. When that line completes, 
execution will proceed to line 0. The B:Wait command again will repeatedly execute 
line 0 until another event is received. 

Events are received when the selected event transitions from unasserted to 
asserted. The event cannot be received again until it becomes unasserted. 

In On Event mode, the “A:Goto 0” command may be moved to another line, but the 
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B:Wait command cannot be moved. 

Single: Single run mode includes a “Stop” command that can be moved to any line. 
When the run button is pressed, pattern execution begins at line 0 and proceeds 
sequentially until the Stop line is executed. When the Stop line completes, execution 
is terminated. 

Custom: In the modes described above, specific commands were set for the user to 
implement common use cases. In custom mode there are no predefined commands. 
Any valid command may be placed on any line.  

Manual: Manual mode allows direct control of the logic outputs by the user.  

V high: Determines the voltage of the probe output when the pattern bit is set to a 1. 
V high must always be greater than V low. 

V low: Determines the voltage of the probe output when the pattern bit is set to a 0. 
V low must always be less than V high. 

Digital Pattern Editor: Displays the current pattern and supports editing vector 
values, durations, actions (commands), and comments. Data is shown in both binary 
form and hexadecimal form. The running time of execution since line 0 and the time 
duration of each vector are displayed. Any assigned commands or user entered 
comments are also displayed. See Other User Controls, Pattern Editing below for a 
discussion of pattern editing.  

Pattern Editor Scroll Bar: Scrolls the vector lines up/down to provide access to all 
of the 1020 vectors. The mouse wheel can also be used to scroll the pattern editor 
window. 

Other User Controls 

Pattern Editing (in the Data Window): Output pattern vectors are shown in two 
formats: binary and hexadecimal. An edit in one of the formats will immediately be 
reflected in the other. 

Editing the binary format data is accomplished by Double-clicking on a binary digit. 
This inverts the bit so that a 1 becomes a 0 and a 0 becomes a 1. 

Double-clicking on a hex value initiates Hex Edit Mode, and the value that was 
double-clicked turns from blue to red. In Hex Edit Mode, hexadecimal characters 
typed on the keyboard overwrite the red highlighted vector value. When the Enter 
key is pressed, the red highlighted vector moves to the next line enabling that line to 
be edited. When no more lines need to be edited, press the ESC key to exit Hex Edit 
Mode. The red highlighted line becomes blue. 
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Changing a Line's Duration: To change the duration of a line, double-click on the 
duration value. A text box appears with the current duration in scientific notation 
(units are seconds). Click in the text box to edit the value. Press the Enter button on 
your keyboard to complete the change. 

You can use scientific notation or use the suffix ‘n’ for ns (nanoseconds), ‘u’ for µs 
(microseconds), or ‘m’ for ms (milliseconds) when entering a new duration value. 
For example you can enter 200n, 0.2u, 200e-9, or 2e-7 to set the duration to 200 
nanoseconds. 

An alternate way to change the duration of a vector is to right-click on the line you 
want to change and select Change duration from the drop-down menu. A similar text 
box is displayed. 

Changing the Duration of All Lines: In the Advanced menu, select Set all duration. 
A blank text box will open. Type in a duration as described above. Press the Enter 
key on the keyboard to complete the change. All vectors are set to the selected 
duration. 

Change the Goto or Stop Line: Right-click on any line in the pattern edit window 
and select Set Loop/Stop Line. Click in the text box and enter a valid line number. 
Press Enter on the keyboard to complete the action. Note that this selection is not 
available when the Run mode is set to Custom. 

Add a Comment on a Line: Double-click on a line in the Action / Comment column. 
A text box will open. Click in the text box and type in your comment from the 
keyboard. Press the Enter key to complete the comment. An alternate way to edit a 
comment is to right-click on the line you want to change and select Add/edit 
Comment from the drop-down menu. Note: comments are only shown on lines 
which do not contain a command. 

Edit a Block of Pattern Vectors: In the Edit menu select Edit Block. The Program 
Edit dialog will be displayed. Select the type of edit and the remaining parameters. 
Help text is provided in the dialog for each block edit type (what it does and how the 
parameters affect the algorithm. Click OK when done and the data will be changed. A 
single level of undo is provided for block edits by selecting Edit, Undo multi-line 
edit. 

Select Input Event Source: In the Advanced menu select Event In and then one of 
the available input event sources. 

Set Logic Family: In the Advanced menu select Logic Family and then one of the 
predefined logic families. This will change the V high and V low settings described 
above. 
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Load a Pattern File: In the File menu select Open. Navigate to the folder that 
contains the previously stored pattern, select the file, and click Open. The pattern 
edit window is overwritten with data loaded from the file. When pattern files are 
loaded the mode is automatically switched to custom. A single level of undo is 
provided for load pattern by selecting Edit, Undo multi-line edit. 

Save a Pattern File: In the file menu select Save As... and then select a folder and file 
name to store the pattern and click Save. Pattern files are saved in a human readable 
CSV format. If you have edited the pattern, you will be prompted to save or discard 
your edits when the Logic Source window is closed. 

Logic Source Operation 

Run Modes 

There are 3 run modes that provide predefined looping constructs. Continuous 
mode provides an infinite loop. Its loop length can be set from 1 to 1020 vectors.  

On Event mode provides triggered bursts. The loop executes once each time the 
specified event is received. This allows the digital pattern execution to be 
coordinated with another MicroBench tool or the activity of the user’s circuit.  

Single mode supports a user initiated burst that starts when the Run button is 
pressed (or clicked). 

These three modes are provided to simplify generation of common pattern types. In 
these modes, the Logic Source software manages the setting of commands for you. 

The Custom mode allows you to be in complete control of the types and placement 
of commands. This allows more complicated sequences to be generated but requires 
knowledge of the Logic Source commands and jump controllers.  

Custom Run Mode 

Custom run mode provides access to most commands via the Logic Source tool 
window. However, to get complete access to the Logic Source commands you must 
write CSV pattern files. 

It is helpful to first understand the address jump controllers. The Logic Source 
includes 3 jump controllers designated A, B, and C. The jump controllers contain a 
jump evaluation type, a target address, and a loop counter. For example, in 
Continuous mode, jump controller A is set to type Always, and its target address is 
set to 0. The Jump A command is placed initially on line 15. When line 15 is 
executed, jump controller A is activated and generates a new next address of 0 
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causing vector execution to jump to address 0. The pattern edit window drop-down 
menu allows you to move the Jump A command placement but not the target line to 
which the jump occurs. When Custom mode is selected this restriction is eliminated. 

For example, when you launch the Logic Source tool, its default mode is Continuous 
and the “A:Goto 0” command is set on line 15. The Logic Source window configures 
the jump controller A type to Always and its target address to line 0. It then sets a 
Jump A command on line 15. 

Selecting Custom run mode allows you to change the Jump A parameters. For 
example, in the Advanced Menu select Configure Jump A. A Dialog box allows you to 
edit the jump controller A type, Jump to line, and loop count. Changing the “Jump to 
line” to 8 and clicking OK changes the command on Line 15 to be “A:Goto 8”. This 
provides an infinite loop structure with a preamble. 

The jump controller functions are: 

● Always: Always jump 

● If (Event): If event is true Jump else execute the next sequential vector 

● If (No Event): If event is false jump else execute the next sequential vector 

● Wait for Event: Hold execution on this vector waiting until the event 
becomes true and then execute the next sequential vector 

● Loop: Jump N times and then execute the next sequential vector 

● Inner Loop: Same as loop except the loop counter is reloaded after it is 
exhausted and then the next sequential vector is executed 

The Jump A, Jump B, or Jump C command can be set on as many lines as you want. 
However, there are only 3 jump controllers. This limits the complexity of structures 
that can be realized. Note that the Stop command does not use a jump controller. 

To set a command on a line in custom mode, right-click on the line and select 
Add/Edit Command, and then the command you wish to place. Remember to 
configure the referenced jump controller when the command is placed (in the 
Advanced menu). To remove a command, select None. 

Generating Logic Source Output Events 

To generate a Logic Source output event on a vector line, right-click on that line and 
select Generate Event. This will cause the Logic Source event to be asserted for the 
duration of that vector. 

One interesting use of events for both sources, Logic Source and Waveform Source, 
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is to use one tool as a clock for the other. For example, the Logic Source can be 
configured in Continuous mode to complete its loop once each second. If an Event 
Out is set on one of the loop vectors, then an output event will be generated every 
second. The Waveform Source can be configured to generate a ramp that goes from 
0 to 5V over a 20ms period every time it receives an Event In from the Logic Source. 
The two tools working together would then produce a 20ms ramp once each second. 

The roles can be reversed with the Waveform Source providing the periodic event 
and the Logic Source bursting a set of vectors on each event. 
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Logic Analyzer Tool 

The Logic Analyzer tool 
provides 9 channels of 
100MS/s digital capture. A 
time span up to 36 
minutes can be captured 
while maintaining 8ns 
resolution for each 
captured edge. 
Three-level triggering 
including value and 
time-qualified triggers can 
capture errors caused by 
missing signal activity. A 
simple, single-window 
user interface makes this 
powerful tool easy to use. 

Logic Analyzer Window Controls 

Waveform Display: Displays captured digital waveform. The timescale indicates 
the time at which edges occur. The Samples value indicates the number of edges that 
must be captured during acquisition to avoid a timeout. The selected logic family is 
displayed below the Samples. 

Display Order: The display order determines which channels are displayed and in 
what order. To reorder or hide channels, click the display order box and enter the 
channel numbers in the desired order. For example enter 0123 to view the bottom 
nibble with channel 0 at the top of the display. Pressing the Enter key on the 
keyboard updates the waveform display with the new display order. 

Watch For A, B, C: Selects a trigger condition. When a trigger is detected and there 
are a sufficient number of edges, the captured trigger value will be placed at the 
center of the screen. 

To select a trigger type, right-click on the trigger window (not the value) or 
right-click the Watch for A/B/C text above the window and select the desired trigger 
type. 

Set the Trigger Value: To change the trigger value, click in the value box in the 
center of the waveform. The value is in binary format. An ‘X’ or ‘x’ value character 
indicates that the bit is don’t care and will not be included in the trigger evaluation. 
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A ‘1’ or ‘0’ value character indicates that the bit position should evaluate true when 
a 1 or 0 value is detected. Space characters may also be included to improve 
readability. Space characters are ignored. 

The characters in the value entry are evaluated from least significant bit (right) to 
most significant bit (left). The first value character X, x, 1, 0 is assigned to channel 0, 
the following value character to channel 1, etc. If fewer than 9 value characters are 
found, the remaining channels will be set to don’t care (X). If more than 9 value 
characters are found the first 9 are used and the rest are ignored. 

Set Trigger Time Parameters: Some trigger types include minimum or maximum 
times as part of the trigger evaluation. To set time parameters click on the 
parameter and edit the value. 

Time values may be entered in scientific notation (units are seconds) or using the 
suffix ‘n’ for ns (nanoseconds)or ‘u’ for µs (microseconds). For example, 200 
nanoseconds can be entered as 200n, 0.2u, 200e-9, 2e-7, etc. 

Capture Button: Start or stop acquisition of a new waveform. 

Run Control Selections: Select the acquisition mode. In continuous mode, 
acquisitions are taken repeatedly. In Single mode, a single acquisition is taken each 
time the Capture Button is pressed. 

Acquisition Timeout: Sets the maximum time that an acquisition will run before it 
is terminated by the timeout condition. An acquisition terminates when the 
requested number of samples have been captured or the duration of the acquisition 
exceeds the timeout value. To disable the timeout feature set the timeout to “None”, 
by right clicking the button until None is displayed or left-click and select None. 

Other User Controls 

Zoom Waveform: Captured waveforms can be scaled by zooming in or out. Zoom 
can be adjusted using the: 

● Front panel Zoom knob 

● Selections in the View menu 

● Selections in the waveform display window right-click menu 

● Mouse scroll wheel (if Wheel Zooms is selected in the waveform right-click 
menu) 

● Drag zoom 

● Double-click zoom 
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● Accelerator keys 'i' and 'o' 

When both A and B marks have been set (See Set Mark A/B below) you can zoom to 
the extent of the marks by selecting Zoom Marks in the waveform display 
drop-down menu or by pressing the 'm' accelerator key. This places the two marks 
near the left and right sides of the display window. 

You can zoom in on a region of the display by dragging the mouse across the time 
area of interest in the waveform display (drag zoom). To drag the mouse, press and 
hold the left mouse button at the starting time to be zoomed. Continuing to hold the 
left mouse button, move the cursor to the ending time to be zoomed. Release the left 
mouse button to complete the zoom area. Area zoom only uses the horizontal (time) 
selection: vertical mouse movement during the drag is ignored. Area zoom may be 
repeated multiple times to view the details of a narrow pulse when a large time span 
is currently displayed. 

You can also zoom by double-clicking on the display. The location of the double-click 
is centered and the scale magnified. Continuing to double-click on a feature of 
interest zooms closer to that feature. 

Scroll Waveform: Captured waveforms can be shifted left/right to view waveform 
data that is currently out of view. Scroll position can be adjusted using the: 

● Front panel Scroll knob 

● Mouse scroll wheel (Select Wheel Scrolls in the waveform right-click menu or 
's' key) 

● Accelerator keys 'j' or 'k' 

Center This: Accessed in the waveform display right-click menu, Center This scrolls 
the display to place the location of the mouse at the time of the right-click in the 
center of the waveform display. 

Goto: Accessed in the waveform display right-click menu, Goto Trigger, prior edge, 
and next edge scrolls the waveform display to place the selected item at the center 
of the display. Goto Mark presents a drop down list of currently placed marks and 
comments. Selecting a mark or comment from the list will center that mark or 
comment in the display. 

Change Channel Labels: To change a timing diagram channel label, double-click the 
label you wish to change. An edit window opens indicating which physical channel 
you are changing. Enter a new label into the text box and click OK.  

Open: Opens a previously stored waveform file for viewing. 

Save As...: Saves the currently displayed acquisition to a waveform file. The 
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waveform can then be opened later for viewing. 

Set Mark: Set Mark places a display mark at the position of the cursor. To place or 
remove a mark on the waveform: 

● Right-click on the waveform at the desired location and select “Set Mark” 
and choose the type of mark 

● Position the cursor at the desired location and click one of the set mark 
accelerator keys: a mark, b mark, ref, time, or quick 

● Press the undo mark accelerator key to remove the last mark that was 
placed 

Marks will snap to a waveform edge if it is within 8 display pixels of the selected 
point and within the waveform. To avoid snap to edge place the cursor outside of 
any waveform or away from a waveform edge. 

When A and B marks are placed, the time difference or frequency (1/time 
difference) between the marks is displayed. Use '/' accelerator key to toggle 
between frequency and time. 

When a Time mark is placed it displays the relative time at that location. If a 
Reference Mark is also placed, the Time marks display the time relative to that 
reference time. If no reference mark has been placed then Time marks are relative 
to the start of acquisition. 

Notation marks allow you to enter the text label associated with the mark. To set a 
notation mark, click in the text box that is opened when Notation is selected. Type 
the label text and then press Enter to set the mark. 

Notation labels must be unique. If a Notation mark is placed with the same label as 
an existing Notation mark, the original mark is deleted before the new mark is 
placed, effectively moving that Notation mark to a new location. 

Set Quick Mark: This mark is like a time mark except that only one Quick Mark can 
be placed at a time. Once a Quick Mark is placed, left-clicking the waveform moves 
the Quick Mark to the click location allowing different time points to be quickly 
measured. 

Set Comment: Comments are like Notation marks (see Set Mark description) except 
that they do not include a mark line, do not snap to edges, and their text label does 
not have to be unique. 

Save View: Adds the current view to the list of annotations with a user defined 
name.  
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Show View: Restores a named view. 

Delete Mark or Comment: Presents a drop down list of marks and comments that 
are currently set. Selecting a mark or comment from the list deletes that mark or 
comment.  The last mark that was placed can be deleted using the 'u' accelerator 
key. 

Delete All Marks and Comments: Deletes all of the currently set marks and 
comments.  

Analyze: This menu provides access to the analyze/decode functions. Multiple 
decoders can be added to an acquisition. 

Select Decoder: Clicking this item will open a drop down selection which allows 
one of the decoders to be applied. Current decoder functions include SPI, I2C, 
RS232, and VALUE. When an analyzer is selected, a configuration dialog is presented 
which is specific to the selected decoder. The configuration dialog allows you to 
assign input channels to the decoder specific signals such as the I2C SCK and SDA 
signals. Specific decoders definition files (dcd) can also be assigned to the decoder. 
Clicking the OK button completes the configuration. 

Configure Decode: Clicking this item will provide a drop down that selects which 
decoder is to be configured. Selecting a decoder will reopen the configuration dialog 
for that decoder allowing the configuration parameters to be modified. 

Enable Decoder: Enables/disables waveform decoding. 

Refresh Decode: Deletes decode marks and re-runs the decoder on the current 
data. 

Clear Decode Marks: Removes all decoder marks. 

The decoder functions work on serial data streams. Decoding the information 
requires that the analyzer align the start of decode with the acquired data set. In 
some cases the data set begins with a partial transaction that includes only a portion 
of the protocol. In these cases the decoder will attempt to form synchronization but 
may be unable to synchronize if insufficient information is available. In these cases 
the user should place a Begin Analysis mark at a location between transactions to 
force correct alignment. Right click in the waveform display and select Set Mark -> 
Begin Analysis. 
If transactions are close to each other in the display their decode text may overlap. 
Zoom in to spread the transactions further apart to eliminate the overlap. 

Remove Decoder: Clicking this item will provide a drop down that selects which 
decoder is to be configured. Selecting a decoder will delete that decoder. 
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Number of Samples: The number of samples that are captured in each acquisition 
can be adjusted by selecting the Advanced, Number of Samples menu. 

Trigger Position: Sets the trigger location within the acquisition. When Start is 
selected, triggering is enabled immediately. When Middle is selected, the trigger is 
not enabled until the number of acquired samples is greater than half the requested 
number of samples. When End is selected, the trigger is not enabled until the 
number of acquired samples is greater than the requested number of samples. 

Logic Family: The logic family being probed can be selected in the Advanced, Logic 
Family menu. The logic family setting is used to determine the logic state of a signal, 
1 or 0. 

Event In: Selects which MicroBench tool will be the source of the Logic Analyzer 
trigger (when trigger type is external event). 

Event Out: Selects when the Logic Analyzer tool generates an output event. 
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Keyboard Shortcuts 

Both Live Logic and Logic Analyzer provide keyboard accelerators that make 
viewing waveforms fast and efficient. Each accelerator key has a corresponding 
context menu control. Below is a list of keys and their function. 

 

Key   Function 

i Zoom in 

o Zoom out 

j Scroll left 

k Scroll right 

n Goto next edge 

p Goto prior edge 

N Goto next edge, jump past local activity 

P Goto prior edge, jump past local activity 

a Set mark A at the cursor location 

b Set mark B at the cursor location 

m Zoom to A and B marks 

z Set mouse wheel mode to zoom 

s Set mouse wheel mode to scroll 

q Set quick mark at the cursor location 

r Set the reference time mark at the cursor location 

t Set the time mark at the cursor location 

u Remove the last mark set 

/ Toggle A-B mark measurement between time and 
frequency 
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Logic Analyzer Operation 

Setting Triggers 

The Logic Analyzer trigger can be used to look for specific logic signal levels or 
behavior and to stop the acquisition ensuring the event of interest is captured in 
memory. Triggers are evaluated each time the logic analyzer inputs change, so if 
there is no activity on the signal inputs, the trigger will evaluate to false. 

The Trigger Position selection determines the number of samples that will be taken 
before triggering is enabled. This allows control of the number of samples that are 
captured before the trigger event. The trigger position can be set to Start, Middle, or 
End. The Start trigger position enables triggers immediately at the beginning of the 
acquisition. The Middle trigger position enables triggering after half of the 
requested samples have been acquired. The End trigger position enables triggers 
after the requested number of samples have been captured. 

Once the trigger evaluation is enabled, acquisition continues until the trigger 
condition is satisfied. Once the trigger condition is satisfied, acquisition continues 
storing additional samples equal to the remainder of the requested samples minus 
the requested trigger position samples. 

The Logic Analyzer tool provides three-level triggering. First the Watch for A trigger 
is evaluated. If the input signals cause the A trigger to become true, the Watch for B 
trigger will become the active trigger. Each following input change will be evaluated 
by the B trigger. If the B trigger evaluates true then the C trigger becomes the active 
trigger. If the C trigger evaluates true the logic analyzer becomes triggered. 

When the logic analyzer is triggered, it will continue to store a fixed number of 
post-trigger samples before terminating the acquisition. This ensures that data 
before and after the trigger are available for viewing. To place the trigger value in 
the center of the timing display, right-click the window and select Center Trigger. 

When an acquisition is started, the Watch for A text color changes from black to red. 
This indicates that the A trigger is the active trigger. If the A trigger is satisfied the 
followed by B text will become red indicating that the B trigger is active. The same is 
true for the followed by C text. If all triggers have been satisfied all trigger labels will 
be black. 
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Time Qualified Triggers 

Time-qualified triggers evaluate the input value of the logic signals and the length of 
time those signals have been stable (time since the prior signal change). There are 
three types of time qualified triggers: 

● Stable longer than time: Evaluates to true only if all input signals have not 
changed state for at least the time specified. If a trigger value is set, then it 
must also evaluate to true. 

● Stable shorter than time: Evaluates to true only if at least one signal has 
changed within the time specified. If a trigger value is set, then it must also 
evaluate to true. 

● Stable for time window: Evaluates to true only if no signal has changed for 
the specified minimum time and at least one signal changes before the 
specified maximum time. If a trigger value is set, then it must also evaluate to 
true. 

Stable longer than time is useful in finding hang problems – when the signal activity 
stops for an extended time due to a software bug or hardware hang. Setting the 
trigger value to don’t cares and the time parameter to a value longer than the 
expected quiescent time of your signals, you can trigger when signal activity hangs. 

Stable shorter than time triggers can be used to catch signals transitioning more 
quickly than expected. For example, if a strobe should last 10µs but is occasionally 
shorter, you can set the time parameter a little less than 10µs and trigger on the 
shortened strobe. 

A word of caution about this trigger type: All active inputs to the logic analyzer are 
evaluated, even if their data value trigger is set to don’t care. If there are several 
signals that transition at the same time, the trigger will also evaluate the 
intermediate states of the transitioning signals. Zooming in on the transaction will 
reveal that the signals actually each changed at slightly different times. If this is a 
problem use the Stable for time window trigger. 

Stable for Time Window is useful for triggering on signals with intermediate states 
that should be ignored. Any state with a duration less than the minimum specified 
time will evaluate to false eliminating intermediate states during transitions. If the 
signal has been stable for more than the minimum time and it transitions before the 
end of the window then the trigger will evaluate to true. The window time is set to 
the minimum acceptable stable value time, so if a trigger occurs, the stable value 
time was not sufficient. 

 
Copyright © 2018 Anewin, LLC. All rights reserved.  
www.fivewirelogic.com Page 46 of 59 



Five Wire User Manual  

Acquisition Termination 

Once the Logic Analyzer acquisition is started, it will terminate when one of three 
conditions occurs: 

1. The user presses the Capture/Stop button 

2. The acquisition time exceeds the timeout value 

3. The logic analyzer is triggered and sufficient post-trigger data values have 
been captured. 

The Logic Analyzer expects to capture a specified number of samples (edges) before 
acquisition is complete. If a sufficient number of samples are not captured within 
the timeout setting, the acquisition will be terminated. If you are capturing low 
repetition rate signals such as wake-up polling strobes, the timeout value can be 
increased to avoid the timeout termination. You can also increase or decrease the 
number of samples required to avoid timeout. 
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I2C Protocol Tool 

 
The I2C Protocol Tool provides both 
master and slave I2C compliant 
capabilities. When in master mode, the 
I2C tool takes control of SCK and SDA to 
generate user defined read and write 
transactions. In slave mode, the I2C tool 
can respond to one or all addresses 
capturing write data and returning user 
defined read data. 

The I2C tool provides a transaction 
viewer and editor. When in master mode the user defines transactions that will be 
placed on the bus. In slave mode, captured transactions are displayed. Transactions 
can be saved to a human readable CSV file and reloaded at a later time. 

Instrument Front Panel Controls 

Send button: The function of the send button changes depending on the mode that 
has been selected: 

● Master mode: Starts execution of the transaction list 

● Slave mode: Starts slave execution providing response to the programmed 
address. 

Run LED: Illuminated when transactions are enabled or occurring. 

I2C Protocol Window Controls 

Send button: Same functions as the front panel send button. See Send button above. 

Master Slave Select: Determines which mode the I2C execution is in. 

Master Controls, Rate: Sets the approximate bit rate of transmission. Note that the 
bit rate can be affected by slave response times 

Master Controls, Stop On Address NACK: If checked, execution will terminate if 
the address transmission does not receive an acknowledge from an addressed slave. 

Slave Controls, Address: Determines which address(es) the I2C tool will respond 
to. An address of 'X' will respond to all addresses. A hex address 0 - 7F will respond 
at that address only. 
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Slave Controls, Continuous: The slave function will continue until the Stop button 
is pressed. 

Slave Controls, Once: The slave function will stop as soon as transaction memory is 
filled. 

Slave Controls, Stop On Event: The slave function will continue until an event is 
received from the selected source or the Stop button is pressed. 

Slave Controls, Enter Slave Read Data: Open the Edit Read Data dialog box. Up to 
8 bytes can be entered in hex. Each byte is returned in order during a read 
transaction. 

Stop On Timeout: If checked, the master or slave function will terminate execution 
when a transaction element takes longer than about 100ms. 

Input Threshold: Determines the voltage boundary between interpretation of the 
input as a logic low or logic high for the SCK and SDA signals. 

Transaction Window Scroll Bar: Scrolls the vector lines up/down to provide 
access of up to 64 transactions. The actual number of transactions that are displayed 
depends upon the number of elements in each transactions and the complexity of 
the I2C traffic. The mouse wheel can also be used to scroll the data and pattern 
editor window. 

Other User Controls 

Master transaction editor: In master mode the Line and Type columns include 
context menus that are opened by right clicking within the intersection of a column 
and line. The Line context menu allows new lines to be inserted or existing lines to 
be deleted. The Type column menu allows transactions and commands to be set on 
that line. Transactions include Start, Read, Write,  and Stop. Commands include Wait 
(time), Wait for event, Send event, Goto (line), and Exit. 

Adding Master I2C transactions: I2C transactions must always begin with a Start. 
When the bus is Idle a Start condition is required to take ownership of the bus. After 
the Start transaction Read and Write transactions may be included. The I2C 
automatically places a Restart condition between each Read or Write transaction 
(although they are not shown in the display). Finally a Stop transaction should be 
added to release ownership of the bus returning to the Idle state. 

Read and Write transactions require an address and data to be entered for the 
transaction. When a Read or Write transaction is selected, an Address Entry dialog 
box is presented. Enter the desired address and click OK or press the enter key. 
Once the address is entered, data edit mode is entered. A '00' hex byte is presented 
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highlighted in red. For Write transactions, entering hex digits on the keyboard will 
change the value of the highlighted value. Pressing the Enter key will fix the current 
value and a new highlighted value is presented. This process can be repeated for up 
to 8 bytes to be written. For read transactions the values cannot be changed. 
However, the number of bytes entered determines how many bytes are read during 
execution. Once the number of desired bytes have been entered pressing the ESC 
key or adding a new transaction on another line will terminate edit mode. 

Write data can be edited or additional Read or Write bytes can be added later by 
double clicking on the byte of interest. However, to remove bytes the transaction 
must be re-entered. 

Adding Master Commands: Commands do not directly affect the I2C bus signals. 
Instead, they alter the timing or sequence of transaction execution. The Wait 
command inserts a time delay of selectable duration from 10us to 500ms. The Wait 
for event command pauses execution until the selected event is received. The Goto 
command jumps execution to the selected line allowing indefinite loops to be 
formed. Send event causes an event to be output on the ProtocolB event line. Exit 
causes execution to terminate and has the same effect as pushing the Stop button. 

Adding Master or Slave Comments: Double click in the Comment column on the 
line the comment is to be placed. A text entry box is opened. Click in the box and 
enter a comment. To edit an existing comment double click on the comment. 

Select Input Event Source: In the Advanced menu, select Event In then one of the 
available input event sources. This menu is only enabled in Master On Event mode. 

Set Logic Family: In the Advanced menu select Logic Family and then one of the 
predefined logic families. This will change the Input Threshold settings to be 
appropriate for that logic family. 

Load a Transaction File: In the File menu select Open. Navigate to the folder that 
contains the previously stored transaction list, select the file, and click Open. The 
transaction window is overwritten with data loaded from the file. 

Save a Transaction File: In the file menu select Save As... Select a folder and file 
name to store the transaction list and click Save. Transaction files are saved in a 
human readable CSV format. 

I2C Protocol Operation 

The I2C Protocol tool can act as an I2C master or an I2C slave. It generates 
transactions using a custom micro-coded protocol engine (uMPE). When the I2C tool 
is started, a program appropriate for selected function is compiled and loaded into 
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hardware. The uMPE executes the program which encodes the protocol behaviors 
and produces the required signals and responses. In master mode the users 
transactions are also compiled providing the I2C activity specified by the user. 

The uMPE executes at 25MHz (40ns) which establishes its maximum time 
resolution. The duration of SCK and SDA cycles are set using uMPE timers. For 
standard I2C speeds SCK the SCK duration is 5 - 10us and the uMPE provides better 
than 1% timing accuracy. uMPE timers are also used to determine if a transaction 
has hung and can terminate execution for further analysis. 

The uMPE includes program and data memory. Program memory contains the 
protocol behavior definitions for both master and slave mode operation. In master 
mode the program memory also includes the compiled user transactions and 
commands. In master mode, data memory contains bytes to be written and bytes 
captured during read transactions. In slave mode data memory contains a record of 
the captured transactions. 

The actual number of transactions and data read write values that can be used with 
the I2C protocol is limited by the program and data memory capacity. In most 
applications there is more than enough memory for transactions and data. However, 
the I2C tool does not contain sufficient memory to emulate large I2C RAM or flash 
memory devices. 

Master Mode 

When the Master mode is selected the I2C Protocol tool acts as the I2C master. It 
generates Start, Restart, Read, and Write transactions that access I2C slave devices. 
In master mode SCK is controlled by the I2C tool. Data bytes can be written to I2C 
slave devices and data bytes read from a slave device are captured for later display. 

To execute I2C Read and Write cycles transaction commands must be entered into 
the transaction window. Below is an example master program. Note that Read and 
Write transactions must be bracketed by Start and Stop transactions. The program 
also shows the use of commands that insert time delay and cause the program to 
loop indefinitely. 

Read and write transactions require an address and data values. When these 
transactions are inserted the user is prompted to enter an address. Once the address 
is entered data bytes that are part of the transaction are entered. The transaction 
window enters data edit mode presenting a hex data byte highlighted in red. For 
Write transactions the byte value is editable by typing hex digits at the keyboard. 
Pressing the Enter key adds another byte. Up to 8 bytes can be added. Read 
transaction data is not editable. It will be overwritten by actual read data during 
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program execution. However, the number of bytes entered is important. A read 
transaction will be terminated with a NACK when the last byte is read. To exit data 
edit mode press the ESC key or enter a new transaction or command on a different 
line. 

Slave Mode 

In slave mode the I2C Protocol tool monitors the SCK and SDA signals for I2C 
transactions. The slave can be configured to respond to all transactions by setting its 
address to 'X' (don't care) or just one address by entering a decimal address value. 
When the I2C tool detects a Start condition it captures the address byte that follows 
and evaluates its contents to determine if it is addressed. If addressed and the R/W 
address field is low, bytes written by the master are captured for later display. If the 
R/W field is high, the I2C tool returns the bytes that were programmed by the user. 
Up to 8 bytes are stored or sent for each transaction. 

To enter the data bytes that will be returned during a Read transaction, click the 
“Edit Slave Read Data” button. This opens a new window that allows up to 8 hex 
values to be entered. During a Read transaction these bytes are returned in the 
order shown. The master device will determine the actual number of bytes read. 

Once the I2C tool is started, it captures all Start, Stop, and Restart conditions. When 
addressed it captures the transactions for its address also. When the I2C tool is 
stopped the captured information is displayed in the transaction window. Display of 
Start, Stop, and Restart conditions can be controlled using the Show Start/Stop and 
Show Restart selections respectively. 

Timeout Conditions 

 The uMPE times the duration of protocol actions that can be extended in time by 
the slave or master to detect hang conditions. A timeout can be caused by the master 
setting the SCK signal high and the slave extending the SCK low to hold off the 
master or due to a protocol fault. Other timeout conditions occur when a transaction 
fails to complete in the timeout period. The I2C tool has a timeout period of 
approximately 100ms. Timeouts can be disabled when appropriate, to aid in 
troubleshooting for example. 

Master Stop On Address NACK 

In master mode the I2C tool executes the transactions defined in the transaction 
window. Each transaction begins with a Start followed by an address byte. If a slave 
exists at the presented address, it returns an ACK signal on the following SCK cycle. 
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If no slave is addressed, the SDA line remains high and the master receives a NACK 
signal. The I2C tool master can be configured to stop execution on an address NACK 
or to continue with the next transaction using the Stop On Address NACK checkbox. 

 

Trigger I/O Protocol Tool 

The optional Trigger I/O Protocol tool 
provides three external trigger inputs 
and three external trigger outputs. The 
trigger probe inputs and outputs can be 
directly connected to the user’s circuit. 
Trigger inputs are high impedance and 
have a settable threshold. Trigger 
outputs have settable high and low logic 
levels. 

Trigger inputs can drive the internal 
events Protocol A and Protocol B. These 
events can be used by any of the Five Wire tools. Trigger outputs can be assigned to 
one of the Five Wire events. 

Trigger I/O Protocol Window Controls 

Output Trigger Source: Assigns one of the internal events to a trigger output. If the 
Invert box is not checked, the output will be high when the selected event is 
asserted. If checked, the output will be low when the selected event is asserted. 

Input Trigger A Source: Selects one of the trigger input signals to drive the Five 
Wire Protocol A event. 

Input Trigger B Source: Selects a logical combination of the trigger input signals to 
drive the Five Wire Protocol B event. 

Input Threshold: Sets the trigger input voltage level that determines evaluation to 
a logic high or low. Voltages above this level evaluate to a 1. Voltages below this 
level evaluate to a 0. 

V high/low: Sets the trigger output voltage levels driven when the selected event is 
asserted or unasserted. 

Other User Controls 

Logic Family: An alternate way to set input/output levels is to select your logic 
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family in the Advanced, Logic Family menu. Input threshold, V high and V low are 
set to the appropriate levels. 

Trigger I/O Protocol Operation 

Trigger Outputs 

Each Five Wire tool generates output events, including the System tool. The Live 
Logic and Logic Analyzer tools assert their event at the start of acquisition or when 
their triggers are satisfied. Waveform Source asserts its event at the start or end of 
each waveform output. Logic Source asserts its event when the line selected by the 
user is executed. The System tool asserts its event when the front panel System 
button is pressed. 

The trigger outputs can be used to coordinate external circuits with Five Wire tool 
activity. They can also be used independently. For example, selecting the System 
event to drive a trigger output provides a manually controlled logic level that can be 
used to test the user’s circuit. If a static level is desired, the Invert box can be used to 
control the trigger output. If a periodic clock is needed and the Waveform Source is 
not in use, it can be configured to generate a periodic waveform at the needed 
frequency. Its event can then be selected as a source for a trigger output. 

Trigger Inputs 

Three trigger inputs are provided by the Trigger I/O Protocol tool. These inputs can 
be used to drive the 2 event outputs, Protocol A and Protocol B. These events can be 
selected by other tools as their input event. For example, the Waveform Source can 
be configured to use the Protocol A event to cause its output waveform to be 
generated. The user's circuit would control the output of an analog waveform. 
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SPI Protocol Tool 

The optional SPI tool includes a 128 
word output queue, which contains 
values to be sent via SDO, and a 128 
word input queue, which stores values 
received from SDI. On each transaction, 
one word in the output queue is 
serialized onto the SDO output signal 
and one word is stored in the input 
queue, deserialized from the SDI input. 
The queue line then is incremented to 
prepare for the next transaction. 
Commands and triggering can change the sequence of execution. When execution is 
stopped, the captured data can be inspected for proper operation. 

The SPI protocol tool provides a hexadecimal pattern editor allowing easy entry of 
output queue data. Captured data is displayed next to output data so transactions 
can be easily evaluated. Master transactions can be single-stepped or sent each time 
an event is asserted. The input and output queues can be saved to a CSV file and 
later restored. 

Instrument Front Panel Controls 

Send button: The function of the send button changes depending on the mode that 
has been selected: 

● Master Single mode: The send button sends one SPI transaction. 

● Master On Event: The send button Starts or stops transmission of SPI 
transactions, with each transaction being driven by the event input. 

● Slave Continuous mode: The send button starts or stops the receipt of SPI 
transactions. 

Run LED: Illuminated when transactions are enabled or occurring. 

SPI Protocol Window Controls 

Send button: Same functions as the front panel send button. See Send button above. 

Restart button: In Master Single mode, the restart button resets the input and 
output queues to line 0. 

Master Single: In master single run mode, a SPI transaction is sent each time the 
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send button is pressed. A red cursor box indicates the next line that will be 
processed. SDI data is updated in real-time so transactions can be immediately 
evaluated. 

Master On Event: In master on event mode, a SPI transaction is sent each time the 
selected input event is asserted. Pressing the send button enables or stops the SPI 
transactions. When stopped, the SDI data display is updated to reflect captured data. 

Events are received when the selected event transitions from unasserted to 
asserted. The event cannot be received again until it becomes unasserted. 

Slave Continuous: In slave continuous mode, SPI transactions are driven by the 
user's SCK. When the Send button is pressed, the SPI Protocol tool will capture and 
respond to SPI transactions. Pressing the send button again will stop the tool and 
the SDI data display will be updated. 

Data Length: Sets the shift length for SPI transactions. 

MSB/LSB First: Sets the order in which SDO data is sent and SDI data is displayed. 

Clock Frequency: Sets the bit clock rate for master modes. 

Clock Invert Polarity: If checked, the master mode clock is asserted low, and in 
slave mode data is clocked in on the negative edge of SCK. 

Input Threshold: Determines the voltage boundary between interpretation of the 
input as a logic low or logic high for the S-SEL, S-SCK, and SDI signals. 

V high: Sets the voltage that will be driven onto M-SEL, M-SCK, and SDO when these 
signals are high. 

V low: Sets the voltage that will be driven onto M-SEL, M-SCK, and SDO when these 
signals are low. 

Trigger button: Opens the trigger dialog allowing the trigger value to be set. 

Skip Jump on Trigger: When checked, the Jump command becomes conditional. In 
this mode, the trigger result from the Jump line determines if the jump is taken. If 
the trigger evaluates to false, the Jump is taken and the next executed line is the 
jump target. If the trigger evaluates to true, the jump falls through and the next 
executed line is the line that follows the Jump line. 

S-SEL Enabled: Enables the slave select input in Slave Continuous mode. 

SEL Asserted low: Determines the polarity of both the M-SEL output and the S-SEL 
input. If checked, these signals are asserted and evaluated as low true. 

Transaction Window Scroll Bar: Scrolls the vector lines up/down to provide 
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access to all of the 128 vectors. The mouse wheel can also be used to scroll the data 
and pattern editor window. 

Other User Controls 

SDO Data Editing: SDO data vectors are shown in hexadecimal format. 
Double-clicking on a hex value initiates Hex Edit Mode (HEM) and the value that was 
double-clicked turns from blue to red. In HEM mode, hexadecimal characters typed 
on the keyboard overwrite the red highlighted vector value. 

When the Enter key is pressed, the red highlighted vector moves to the next line 
enabling that line to be edited. When no more lines need to be edited, press the ESC 
key to exit HEM mode. The red highlighted line becomes blue. 

Add a Goto 0 command: Right-click on any line in the transaction window and 
select Goto 0. A Goto 0 command is placed on that line. Only one Goto 0 command 
can be set. The Goto target is always line 0. Goto 0 allows a set of SPI transactions to 
be repeated indefinitely. 

Add a Jump Command: Right-click on any line in the transaction window and 
select “Jump to.” Click in the text box and enter a line number between 0 and 127. 
Only one Jump command can be set. The target line is selectable by the user. The 
Jump command can be made conditional based on the programmed trigger. This 
allows wait loops to be generated that send a transaction or set of transactions until 
an expected response is returned. When triggered the Jump is not taken and the 
next sequential vector is executed. 

Add a Stop Command: Right-click on any line in the transaction window and select 
Stop. A Stop command is placed on that line. When a stop command is executed the 
tool stops executing transactions and displays captured SDI data. 

Add a Generate Event: Right-click on any line in the transaction window and select 
Generate Event. An Output Event A command is placed on that line. When the line is 
executed, Protocol A output event will be asserted. 

Add a Comment on a Line: Double-click on a line in the Action / Comment column 
or right-click and select Add/Edit Comment. A text box will open. Click in the text 
box and type in your comment from the keyboard. Press the Enter key to complete 
the comment. Note that comments are only shown on lines which do not contain a 
command. 

Select Input Event Source: In the Advanced menu, select Event In then one of the 
available input event sources. This menu is only enabled in Master On Event mode. 

Set Logic Family: In the Advanced menu select Logic Family and then one of the 
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predefined logic families. This will change the V high, V low, and Input Threshold 
settings to be appropriate for that logic family. 

Load a Pattern File: In the File menu select Open. Navigate to the folder that 
contains the previously stored pattern, select the file, and click Open. The pattern 
edit window is overwritten with data loaded from the file. 

Save a Pattern File: In the file menu select Save As... Select a folder and file name to 
store the pattern and click Save. Pattern files are saved in a human readable CSV 
format. 

SPI Protocol Operation 

Master Mode 

When Master Single or Master On Event modes are selected the SPI Protocol tool 
acts as the SPI master. It generates M-SCK to shift data out of SDO and captures data 
received on SDI. 

Master Single mode provides single-step operation. A transaction is initiated each 
time the Send button is pressed. A cursor box is drawn around the line that is to be 
executed. The SDO data in the cursor box is sent and the SDI Data in the cursor box 
is received. The display is updated with the received data and the cursor box is 
moved to the next executing line. 

Master On event allows transactions to be sent periodically or triggered by a user 
signal. Each time the selected input event is asserted, a SPI transaction is initiated. 
SDI input data is captured but the display is not updated until the tool is stopped. 

Slave Mode 

In Slave Continuous mode the SPI Protocol tool acts as a slave. The Send button 
starts the tool and it waits for transitions on the S-SCK input. During a transaction 
the output queue generates the data sent on SDO, and data received on SDI is 
captured to the input queue. The SPI Protocol tool can then be stopped by pressing 
the send button, and the SDI data display will be updated with the captured values. 

Sequence Commands 

The SPI Protocol provides three pattern sequence commands: Goto 0, Jump, and 
Stop. The Goto 0 command can be placed on any line and causes execution to restart 
at line 0. This provides a simple infinite loop mechanism. 

The Jump command specifies the target line of the jump. The jump can be forward, 
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backward, or can be to the same line that contains the jump command. The jump 
command can be configured as a jump always or a conditional jump. When 
conditional, the jump is taken if the trigger evaluates to false on that line. If the 
trigger evaluates to true, the jump falls through and the next sequential line is 
executed. This allows a tight loop to be formed that continuously polls for a value 
and then continues when the value is received. The Goto 0 and Jump commands may 
be combined to provide complex sequence control. However, only one Goto 0 and 
one Jump command can be placed in the queue. 

The Stop command terminates the SPI Protocol tool execution and displays 
captured data. 

Triggers 

The SPI Protocol tool provides a single trigger that evaluates SDI data. Trigger 
values are encoded in binary format. An ‘X’ or ‘x’ value character indicates that the 
bit is don’t care and should not be included in the trigger evaluation. A ‘1’ or ‘0’ value 
character indicates that the bit position should evaluate true when a 1 or 0 value is 
detected. Space characters may also be included to improve readability. Space 
characters are ignored. Each byte in the trigger is shown separately but they all 
contribute to trigger evaluation. 

The characters in the trigger entry are evaluated from right to left. The first value 
character X, x, 1, 0 is assigned to bit 0, the following value character to bit 1, etc. If 
fewer than 8 value characters are found, the remaining bits will be set to don’t care 
(X). 

The result of trigger evaluation is driven onto protocol event output B for use by 
other tools. If the Skip Jump on Trigger box is checked in the trigger dialog, the Jump 
command becomes conditional based on the trigger result. 
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